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Abstract

Welcometo M3T-PD30SIM V.5.20 Release 1A (called PD30SIM).

Thismaterial explainsthe contents of this softwar e, installation procedur e, and supplementsto the user’ smanual and help. When
using this softwar e, pleasetakealook at thisrelease note aswel asthe user’s manual.

Also, thismaterial containsa License Agreement in thelast. Pleaseread it beforeusing. By using the softwar e, you are accepting and
agreeing to such terms.

** You can get thelatest ver son of thisdocument from our homepage: Homepage. (http:/Awww.renesascom/en/tools)
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1 Componentsof the Product
The following files comprise the package of PD30SIM V.5.20 Release 1A(English version). The License 1D
Certificate/lUser Registration Sheet is not included in the package for upgrading.

Bm  Contents of the CD-ROM

1. Filesof ingdler for PD30SIM
The following files are ingtalled after running the ingtaller for PD30SIM.

(1) Programs and concerned files
® PD30SIM.EXE V.7.20.00
o xoooxdl

P30SDLL.DLL V.1.20.00 P30SEVENTSETTING.DLL V.1.20.00
COMMUNI.DLL V.201.04 P30SRTOSWIN.DLL V. 1.20.00
P30SGUI.DLL V.1.20.00 P30SSIMWIN.DLL V. 1.20.00
P30SCBENGINE.DLL V.1.20.00 P30SGUIIOWIN.DLL V.1.20.00
MFC42.DLL MSVCRT.DLL
ATL.DLL

® MCUfiles

| M16C6x.MCU | M16C3x.MCU M16C2x.MCU M16C1x.MCU R8CIx.MCU
SIM30.EXE Ver.4.20.00
PDHELP.CHM
PD30SIMDLL.DEF
PD30SIM.RDF
PD30SIM.FEF
DEFAULT.SCK
® |/O Script sample programs

The following software is attached as service software.
CB30SIM.EXE V.11101

CB30SGUI.DLL CB30SIM library files
MA.EXE, MADLL.DLL CB30SIM includefiles
MC.EXE, MCDLL.DLL CB30SIM sample programs
ML.EXE, MLDLL.DLL CB30SIM.HLP
MCPP.EXE, MCPPDLL.DLL CB30SIM.RDF

MCC.EXE

(2) Documents

Descriptions File Names
Simulator Debugger User’s Manual* PDSUE.PDF
Introducing 1/0O Script Sample Programs PD30SSE.PDF
CB30SIM User's manua CB30SUE.PDF
CB30SIM Programming manual CB30SUPE.PDF
CB30SIM Sample program manual CB30SSE.PDF

(3) HTML Help Update Component
You may need HTML Help Update Component (Microsoft Incorporated products) to browse HTML Help Files
(.CHM). Ingal and update this component in your system, if you can’t open help for PD30SIM.(NOTE: Y ou need
restart your system after theingtalling)

! The User's Manual is shared with PD308SIM V.3.XX and PD30SIM V.5.XX.
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B Reease Notefor PD30SIM V.5.20 Release 1A (It'sthis hote, which contains “ Software User License Agreement”.)
B License|D Certificate/lUser Registration Sheet

® [f any of the above is missing, contact either Renesas Technology Corporation's office or its distributor

from which you purchased the product.
® Pleaseread alicense Agreement before using. By using the software, you are accepting and agreeing to

such terms.
® The S/W Tool User Regigtration Sheet is used for maintenance service for you.
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2 Operating Environment
PD30SIM runs on the host machine environments given below.

Table 1:Host M achine Environments

Host Machine IBM PC/AT compatibles
Operating System WindowsMe
Windows 98
Windows XP
Windows 2000
WindowsNT 4.0
CPU Pentium 11 233MHz or higher CPU is recommended.
Memory 128MB or more system memory is recommended.
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3 Installation
The following shows ingtallation procedure of PD30SIM.

[Notesfor Windows XP/2000/NT 4.0]
Make sure that indtaller is executed by one who is authorized as an Administrator. No one but the user who has the authority
of an Administrator caningtall the PD30SIM.

3.1 Toinstall PD30SIM
Please install the Installing the debugger according to the following procedures.

1. Sartofingaler
Please execute "Setup.exe’ which is in the ¥PD30SIM¥W95E folder of the product CD-ROM, from Explorer or
any other launcher program.

2. LicenslID
In "License ID" didog box, please select the “Norma Licensg” and input the license ID. License |D(XXXX-XXXX-
XXXX-XXXX-XXXX) IS described in license I D Certificate. (appended to the product package)

3. Display of product license
The " Software License Agreement” dialog box displays the content of the license agreement. Please read the content
of the contract.

4.  Input of user information
In "Customer Information” dialog box, please input customer information (License User, Belong To, Your
Addresses, and PC types). Input information becomes aformat of a customer support by mail.

5. Sdection of component
In"Sdect Components' dialog box, please select the ingtalled component. This dialog box can change the directory
the installation ahead.

6. Endof theingtaler
The ingtallation of PD30SIM is complete, when the dialog box which indicates “ Setup is complete”.

3.2 User Registration
Thetext file for the user registration is created to the start menu. Please input a necessary matter to the text file and
send it to the registration desk (regist_tool @renesas.com) in our company by e-mail. To open the text file for the user
registration, please select the following menu:
Windows Menu [ Start]->[Program]->[RENESAS-TOOL §]->
[PD30SIM V.5.20 Release 1A]->[User Registration Sheet]

If you would like to register your information by FAX, pleasefill in the contents of the License ID certificate and
send it to the registration desk (81-6-6398-6191).

3.3 Toinstall Acrobat Reader

The manual of PD30SIM is offered as an electronic manual. Acrobat Reader is necessary to refer to an electronic
manual. Please install Acrobat Reader if necessary. Acrobat Reader can be downloaded from the home page of the
Adobe Systems Incorporated products.
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URL for Adobe Systems Incorporated: http://www.adobe.co.jp/

3.4 Tolnstall HTML Help Update Component

The Online Help for PD30SIM is offered asaHTML Help file. Internet Explorer 4.0 or later is necessary to browse HTML
Help files.

If you can't browse HTML Hep files, you need ingtal Internet Explorer 4.0 or later, or ingal HTML Help Update
Component, or Ingtall both of them.

HTML Hep Update Component (HHUPD.EXE) is appended below “Utility” folder where PD30SIM ingtaled. This
component can be downloaded from the home page of Microsoft co.

URL for MSDN: http://msdn.microsoft.conV/
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4 A Request Concerning Technical Support
4.1 Technical support by E-mail

Thetext file for the technical support is created to the start menu. Pleasefill init and send it to your nearest Renesas office or
itsdistributor by E-mail. To open the text file for technical support, please select the following menu:
Windows Menu [Start]->[Program]->[RENESAS- TOOL §]->
[PD30SIM V.5.20 Release 1A]->[Technica Support Sheet]

4.2 Technical support by FAX

Please fill in the “Technica Support Communication Sheet”, which is the last page of User’'s Manual, and send it to your
nearest Renesas office or itsdigtributor by FAX.

[Notesfor technical support]
We appoint the types of host machines (IBM PC/AT compatibles, for example) as an operation environment for usng our
software tools. This does not guarantee operation on dl the types of the host machines or in any environment of them
(device drivers, periphera units, etc.), but merely for indicating an operation environment we assume (to be put to our
support). If a trouble should occur in using the software tools in the operation environment we appointed, we offer a
technical support to solve the trouble (correct the defective condition, inform away of avoiding the trouble, and so forth).

If atrouble that occurred in your environment cannot be reproduced in our operation environment, we may ask a favor of
you to solve the trouble (we may borrow your equipment with your approval). We would like to obtain your prior approval.

4.3 Technical support by Homepage

Our homepage in the following URL provides datashests, toolnews, FAQ and the other informations of our products.
Home Page: http://www.renesas.com/en/tools/

Another accessis:

Windows Menu [ Start]->[Program]->[RENESAS-TOOL §]-> [(Link Page for) RENESAS Tools HomePage]
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5 Notes
5.1 Treatmentsof Filesand Directories
PD30SIM runs under Windows Me/98/X P/2000/NT 4.0, but the following points should be noted:
1. Useonly oneperiod in afilename.
2. You cannot use anetwork pathname. Y ou mugt alocate adrive.
3. Notethefollowing congtraints:
- Do not use directory names or filenames that include blanks.

- Youcannot use"..." to specify two level s upper directories.

5.2 Precautionson Using M 16C/62 Group
PD30SIM does not support the M16C/62 group's memory extension mode.  (Only the norma mode is supported.)

5.3 Regarding the number of data that can be acquired on virtual port output or output port windows

The maximum number of data that can be acquired on I/O window's virtual port output or output port windows can be
specified in the Init dialog box. We recommend specifying a value less than 500,000 for this data count. Specifying any vaue
greater than that may cause the performance of PD30SIM or Windowsto drop.

5.4 On watching thelocal C variables
For the sake of optimization, the C compiler may place different variables a the same address. In this case, values of the C
variable may not be displayed correctly on the ¢ watch window or other function.

5.5 On debugging the Bool type

PD30SIM do not support _Bool type debugging. When downloading a program with _Bool type, following error occurs in
PD30SIM: “ERROR 6200: SYMBOL fileisillegal.”

Touse_Bool type, specify either -gbool_to_char or -gBTC for the debug option when you compileit.
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6 Supplementsof HTML Help

6.1 A precaution of MCU files

Some of the contents of the MCU file are changed at PD30SIM V.5.20 or later. Therefore, when setting the MCU filein setting
up the PD30SIM, you must sdlect an MCU file, which isavailable to the new version. If an MCU file attached to PD30SIM
V.5.10 Release 1 or earlier version is selected, error occurs.

6.1.1 List of MCU Files attached to PD30SIM

MCU FileName MCU

M16¢6x.mcu M16C/60 Series
M16c3x.mcu M16C/30 Series
M16c2x.mcu M16C/Tiny, M16C/20 Series
M16cix.mcu M16C/10 Series

R8c1x.mcu R8C/Tiny Series

(Note)
® MCU filesareincluded in the directory where PD30SIM ingalled (ex: C:¥MTOOL¥PD30SIM¥M cuFiles).

6.2 About Debug Functionsfor the OSEK OS
PD30SIM supports the following debug functions for the OSEK OS (for M16C/6N):
®Runtime Osek window (custom window)
Shows the gtatus of the OSEK OS resources by sampling while executing the target.

6.2.1 Regigtering the Runtime Osek window in PD30SIM
The Runtime Osek window is a custom window created using the customize functions of PD30SIM.
When PD30SIM isingalled, variousfiles of the runtime Osek window are copied to the directory shown below.

Directory File name
[MTOOL]¥PD30SIM¥Macro¥osek osek_win.p (program file)
osek_win j.pdf (PDFfile)

(* [MTOOL] denotesthe directory you specified when ingtalling PD30SIM).

To use the runtime Osek window, you need to regigter this custom window to the PD30SIM menus. Select PD30SIM menus
[Optional Windows] -> [Custom Windows] -> [Options], and a Custom Window Option dialog box appears. Register the
above path and window name (e.g., OSEK) in this dialog box. (For details, see PD30SIM help "Regigtering custom windows.")
For details about the functions of the runtime Osek window and how to use it, see the attached PDF file.

6.3 About the Attached Custom Windows

The custom windows and custom commands listed below are attached to PD30SIM.

When PD30SIM isingaled, variousfiles of the attached custom commands are copied to the directory shown below.
[MTOOL]¥PD30SIM¥Macro

(* [MTOOL] denotes the directory you specified when ingtalling PD30SIM.)

<<Lig of attached custom windows>>
®Custom Dump Window
Directory in which the attached files are stored:

Directory File name
DumpWin dump_win.p
dump win_epdf

Functions;
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Thiswindow can change the number of columns (1-32) in arow.
For details about this window and how to useit, see the dump_win_e.pdf.

®OSEK Window
Directory in which the attached files are stored:
Directory File name
OSEK osek_win.p
osek_win e.pdf
Functions:

Thiswindow helps your debugging of OSEK OS (for M16C/6N) program.
For details about this window, please refer to “6.2 About Debug Functions for the OSEK OS’ and the osek_win_e.pdf.
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7 Regarding I/O Script Sample Programs

PD30SIM has al/O script function as a means of smulating the operation of internal devices (e.g., timers and CRC arithmetic
circuits).

Try using the 1/0 script sample program included with this product. It contains a description of internal device operation.

For details about specifications of and the method for using this I/O script sample program, refer to the eectronic manual,
"Introducing 1/O Script Sample Programs."

8 Regarding CB30SIM and Custom Function
For details about the functions of and the method for usng CB30SIM, refer to the eectronic manuals, "CB30SIM User's
Manud," "CB30SIM Programming Manua," and "The introduction of the sample programs for CB30SIM.."
CB30SIM and custom window functions are the service tool s attached to PD30SIM.
Thistechnica support copeswith it by inserting the newest information in the homepage.
(URL : http://www.renesas.com/en/tools)
And, as for the question which fills the following condition, approve it in advance because it becomes support within our
possible span though it lets me cope with it by electronic mail.
(It has the possibility that we can't necessarily meet dl question and requests.)
©® Ask me aquestion by electronic mail at our company support counter.
(support_tool @renesas.com)
® Attach the source file of the sample program and binary to the electronic mail when you ask it a question about faulty
operation of the custom window which a customer made.(As for the program, remove al the parts which aren't concerned
with the true nature of the problem.)
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9 Version Report
This section describes the specification of the changed software.

9.1 PD30SIM V.5.20 Release 1, PD30SIM V.5.20 Release 1A
In this version, the following specifications were changed from former version PD30SIM V.5.10 Rdease 1.

9.1.1Functional Extensons
® Support for the R8C/Tiny series.
® Thefile, which isopened in Program window and Source window, can be opened with HEW, when PD30SIM started up
by the external debugger of HEW.

9.2 PD30SIM V.5.10 Release 1
In this version, the following specifications were changed from former version PD30SIM V.5.00 Release 1.

9.2.1 Revisonsfor Restrictions

® A limitation has been corrected that if you try to open dialog boxes (for setting breskpoints and changing windows etc.)
during execution of target programs, those dialog boxes may not appear, and the subsequent operations become frozen.
(for detall, refer to the MAEC TOOL NEWS, May 16, 2001)

® A limitation has been corrected that debuggers may be terminated forcibly when variables are entered in the C watch
window.
(for detall, refer to the MAEC TOOL NEWS, Augugt 1, 2001)

® A limitation has been corrected that if a Windows application is launched or any of the other dready-opened Windows
gpplications is made active while you are downloading a target program (a load module), the debugger may freeze
suddenly.
(for detall, refer to the MAEC TOOL NEWS, December 16, 2001)

® A limitation has been corrected that the Source window may not be opened or not digplay materials normally if opened.
(for detall, refer to the MAEC TOOL NEWS, December 16, 2001)

® A limitation has been corrected that even when a search path is set usng the Customize dialog box or the Path script
commands, the source file located by the search path may not be displayed in the Program window and others.
(for detall, refer to the MAEC TOOL NEWS, December 16, 2001)

® A limitation has been corrected that when data is transferred by an MOV ingtruction using the SP relative addressing
mode, the S flag will not be cleared to "0" but incorrectly be set to "1" if the MSB value of the lower 8 bits of dest
(degtination) is"1", even though the value of the MSB of destis"0".
(for detall, refer to the MAEC TOOL NEWS, November 16, 2002)

® A limitation has been corrected that smulator debugger may be hung when coverage datais set.
(for detall, refer to the MAEC TOOL NEWS, December 16, 2002)

9.3 PD30SIM V.5.00 Release 1
In this version, the following specifications were changed from former version PD30SIM V.4.00 Release 1.

9.3.1 Revisonsfor Restrictions

® A limitation has been corrected that when the memory content at a 2-byte or 4-byte watch point arting from an odd
addressisatered in the ASM Watch Window, acommunication protocol error occurs.
(for detall, refer to the MESC TOOL NEWS, December 1,1999)

® A limitation has been corrected that if the MR Window MPL mode is displayed, a Windows error message " Performed
anillega operation" may be output.
(for detalil, refer to the MESC TOOL NEWS, June 1, 2000)

® A limitation has been corrected that when operating in the Program or Source window's Source dialog box (opened from
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View -> Source buttor/menu) a Windows error message is digplayed and the operation isforcibly terminated.
(for detall, refer to the MESC TOOL NEWS, June. 16, 2000)

® A limitation has been corrected that if any structure whose member names exceed 1,024 charactersin totd isdisplayed on
the C Watch, Global, File Locd, or Loca window, the debugger may be forcibly terminated.
(for detalil, refer to the MESC TOOL NEWS, October 16, 2000)

® A limitation has been corrected that when referencing 32-bit register variables from the C Watch or Local window or
with the print command, the software does not display correct values.
(for detalil, refer to the MAEC TOOL NEWS, May 16, 2001 )

9.3.2 Functional Extensions
® \Window-related Functions
- Trace Window
» A window has been added that records and references the history of target program execution.
- Trace Point Setting Window
A window has been added that sets conditions under which to start or finish tracing.
- Output Port Window
A window has been added that outputs the data which normally are forwarded to portsto awindow or file. It helps
to output the results of the printf function, a standard output function of the C compiler NC30.
- GUI Input Window
* Bitinputs and multi-byte inputs are now accepted.
* A part has been added that shows strings.
- GUI Output Window
» Thenumber of addressesthat can be set in acreated part has been increased to a maximum of 200.
* A part has been added that shows strings.
- 1/OWindow
* A dialog box has been added that helpsto set smple timer interrupts.
* Virtua port inputs, virtua interrupts, and 1/0 script procedures can now be registered in up to amaximum of 50 in
total.
- Init dialog box
* Tabs have been added to the Init dialog box, and size of the dialog box has been reduced.
* A function has been added that allows you to specify the MCU file that contains the MCU'sinherent information.
The information of thisMCU fileis used by the Output port window.
* A function has been added that allows you to specify the CPU's operating clock frequency. The CPU's operating
clock frequency is used in execution time measurements or Smple timer interrupts.
* A function has been added that allows you to specify the number of cycles for which time the trace results can be
recorded.
* A function has been added that allows you to specify the maximum number of data that can be acquired on 1/0
window's virtua port output or output port windows
- Program/Source Windows
* Sourcefile editing function has been added.
* It has been available to save the M1 X mode display to text files.
* It has been available to input sourcefiles namesin the Source Diadlog Box immediately.
- Memory Window
The following function has been added; the beginning of the display are changed to the position which correspondsto
gsack pointers.
- ASM Watch Window
The following functions have been added.
» Watch points are also digplayed in signed decimal
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» The Refresh Button is added. Y ou can update the display of the memory contents.
Cdl Stack Window
Call Stack Window has been added. Thiswindow displays function call information of C language.
Dump Window and Memory Window
* You can specify agtart addressfor display, when you open a Dump Window or a Memory Window.
» Thedart address of the Dump Window or the Memory Window is displayed on thetitle bar.
RAM Monitor Window
» Thedart address of the RAM Monitor Window is displayed on itstitle bar.
C Watch Window and ASM Watch Window
* You can specify where C and ASM watch point fileis saved.
* You can save C and ASM waetch pointsin project-wise.
Script Window
» Command history is saved. When you type up-arrow or down-arrow key on theinput field in focus, commandsin
the history appear in order.
* RELOAD command is added. This command loads your last target program again.
PD Window
* You can switch the display of the toolbar on or off.
» The execution time of a program was displayed on the Satus bar.
Find dialog box
 Higory of searching key words becomesto be held.
Script commands
TraceData (TD) command
» A command has been added that displays access information on trace result memory.
Traceligt (TL) command
» A command has been added that displays the disassembled result of trace results.
TracePoint (TP) command
» A command has been added that sets conditions under which to start or finish tracing.
The Others
Support the Drag-and-drop Operations.
With the drag-and-drop operations, you can load files, set events, set beginnings of displays, add watch points, set or
move data, and so on.
Auto Completion for the Address Setting.
When you input some charactersfor the label string in the address setting combo-boxes, the characters are completed to
alabd gring that corresponds.
Buttons on the Toolbars
 The buttons on the toolbars has been resized smaller and changed to the icons.
* You can switch styles of buttons.
Customizing of User Interfaces
Shortcut key assignment and toolbar customizing functions have been added.
Shortcut menu
Right click on each window displays its own option menu as shortcut menu.
Supplemental Download Function for Binary Data
After downloading of an absolute modulefile, Y ou can download supplementa binary data (HEX filesor MOT files)
with keeping symbol debugging information.
Saving window information and Resuming
Size, location and the other information of each window resumes at opening each window. This resuming function had
worked only at starting PD30SIM.
Ligting of All Labelsin Address Setting Fields
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All labels arelisted in each address setting fields. When you set alabel for an address, you can select it from thelist.
- OnlineHep
Online help has been changed to HTML Help.

9.3.3 Specification Changes
® \Window-related Functions
- Source Window
* Source windows can be opened up to 30.
Dump Window and Memory Window
» Dump Windows can be opened up to 30. And Memory Windows have also.
Script Window
* Script files can be nested to 10.
256 macro defines a script file has available.
- Customize Dialog Box
» Customize Dialog Box has changed to Property sheet. Settings for customizing (settings of shortcut keys, download,
fonts, path, tools and the others) are unified into one dialog box.
® Script commands
- CYde(CY) command
 Thiscommand now displays the number of execution cycles and the execution time.
® The Others
- 1/O Script file
» Thedefault extension for 1/0 script files has been changed from ".scr to ".ios"
- Download Higtory Function
* You can specify the number of remembering files, which have been downloaded, from 1 to 16.
- Changesof Appearances
 Appearances of the buttons on the toolbar of PD Window have been changed.
 Arrangements of apart of the menu items have been changed.
» Appearances of Upload dialog box and Save Disasm Dialog box have been changed.
- CB
A part of functions added to PD has available.

9.4 PD30SIM V.4.00 Release 1
In this version, the following specifications were changed from former version PD30SIM V.3.00 Release 1.

9.4.1 Correction of Restrictions
® Thefollowing restrictions concerning upload function have been modified.
- If aMotorola S-format file is crested using the [File] [Upload] menu or "UploadMot" command, the check sum of the
end record is not correct.
- If a Motorola Sformat file of a certain address range is created using the [File] [Upload] menu or "UploadMot"
command, data of part of the range may not be output.
® A limitation that when you download the absolute module file, which includes over 127 sections, PD30SIM outputs the
error and fail to download it.
® The redriction that the auto variables registered in C Watch Window / Locd Window are not displayed when you use
module files created by AR C compiler has been modified.

9.4.2 Functiona Extensions
® Window-related
- Program/source window
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* A function that displays C variable on the popup window when in the source display mode and the mouse cursor is
placed on the C variable for a certain period of time has been added.
* A function that displays measurement results of coverage has been added.
* Operation has been facilitated by right-click menusthat let you jump to the selected function, or |et you register
items on the C watch window of the selected variable.
* You can now change the characters and background color of text, PC line or coverageline.
* You can now switch from disassemble display mode to source display mode or mix display mode even if the Sart
addresses don't match.
» The system now switches automaticaly to the selected display mode if the pause position of the target program can
be displayed by the display mode selected from the menu or tool bar (program window only).
Dump/memory window
* A Japanese code display function has been added. SJIS or J'S code characters can now be displayed when in word
display mode.
* You can now set arange of addresses selected by the cursor (Start, End) as the start and end addresses for Fill or
Move dialog boxes.
C watch window
» Cwatch display RAM monitor
Y ou can now view C variableswhile the target programis running.
* Radix can now be changed for each variable.
« If Cvariablesarearray type, you can now expand and display the el ements of the array. Now you can aso display
the object of the pointer if the C variables are pointer type.
Script window
* A function that records executed commandsin afile has been added. Unlike alogging function, only the command
itself isrecorded s0 the saved file can be used as a script file.
Coverage window added
MR window added
Script commands
MOV EWord command added
This command moves a memory in the Word unit.
Others
Addition of download history function
A function that displaysalist of files (4) for which download has been executed at the bottom of the file menu has been
added. Y ou can re-download afile by sdecting it fromthelist.
Addition of automatic download function when updating load module
A function that automatically downloads when the target program is updated has been added.
Addition of file format that can be downloaded from amenu
Y ou can now select file formats supported by script command only (Intel HEX format, | EEE-695 absolute format, etc.)
from the menu.
C address input support
Y ou can now input all addresses (diaog, etc.) in both ASM or C.
Addition of GoFree menu
Free run which used to be supported by GoFree command only can now be executed from the menu.
Addition of scope switch dialog box
The scope setting function which used to be supported by SCOPE command is now supported by GUI.
Addition of Options menu
A function for customizing PD30SIM operation has been added.
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9.4.3 Specification Changes
® \Window-related
- Register window
Size of the window has been reduced, and font change is now supported.

9.5 PD30SIM V.3.00 Release 1
In this version, the following specifications were changed from former version PDB30SIM V.2.00 Release 1.

9.5.1 Correction of Restrictions

® A redriction that if after cresting C source and assembler source files of the same file name (e.g., Samplec and
Sample.a30) you downloaded the x30 file including those files by the on-memory method (a method for reading debug
information) an error message "File format is illegad" was displayed and the downloading was aborted, has been
corrected.

® A regtriction that if you downloaded an absolute module file (x30 file) created by linker In30 using command parameters
condsting of more than 255 characters, an error message "File format isillegal” was displayed and the downloading was
aborted, has been corrected.

® A redriction that if in the MOV ingtruction where dest is the address register, you transferred negative data in length of
byte and quick format (F8H to FFH), the src data was transferred in 16 bits after being sign-extended (FFF8H to FFFFH)
in stead of being zero-extended (O0F8H to O0OFFH), has been corrected.

9.5.2 Functional Extensions
® \Window-related
- 1/Owindow added
Thiswindow isused to set or display virtual port input, virtual port output, and virtual interrupt. Settings of virtual port
input and virtud interrupt and the results of virtual port output can be referenced in chart, numeric, or graph form.
- GUI input window added
It alows you to create asimple key input panel (buttons) of the user target system on awindow and perform virtual port
input or virtual interrupt by pressing the buttons you've created.
- GUI output window added
It alows you to implement asimple output panel of the user target system on awindow.
® Script commands
- MR command
Functionsto reference the system timer, issue system cdlls, and reference memory pools have been added.
® Others
- 1/O script function
It allows you write settings of virtual port input or virtua interrupt to afilein script form.
- Function to specify directory in which to create temporary file
If an on-demand method is specified when downloading the target program, the system crestesatemporary file. A
function to specify directory in which to create temporary file hasbeen added in thisversion.  Usethe Init dialog box
to specify the direction in which you want atemporary file to be created.
- Support for C compiler ICCM16C available from IAR
Using the Init didlog box that opens when PD30SIM isinvoked, choose ICCM 16C as the compiler you want to use.
- Function to restore last state terminated has been added.
PD30SIM can beinvoked in the last state it was terminated previoudy, i.e., the previous window position, size, etc. are
restored when you start up PD30SIM.
- Function to save and read software breakpoints
A function to save and read software breakpoints hasbeen added.  Thisfunction is used from the S'W breakpoint
setup dialog box.
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9.5.3 Specification Changes
® \Window-related
- Program/source window
A function has been added that allows you to line-assemble from a specified position.
A MIX display mode has been added in which source and disassembled result are displayed together.
- Source window
A change has been made so that the window will not be closed when downloading the target program.  However, if
you delete the source file being displayed, the window is closed.
- RAM monitor window/ASM watch window
Even when the window is closed, settings of display color and sampling period are retained.
® Script commands
- PORT command
The PORT command, which was used to emulate ports, has been del eted.
- INTerRupt command
The INTerRupt command, which was used to generate pseudo-interrupts, has been deleted.
® Others
- Namechange
The software name has been changed from PDB30SIM to PD30SIM.
- Temination of PD30SIM
A change has been made so that PD30SIM now can be terminated while executing the target program.
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[MEMO]
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10 License Agreement

IMPORTANT Licensed Copy Number: 1 Copy

DO NOT OPEN THIS PACKAGE NOR INSTALL THE SOFTWARE UNTIL YOU HAVE READ AND
AGREED TO THE TERMS AND CONDITIONS SPECIFIED IN THE SOFTWARE USER LICENSE
AGREEMENT BELOW

Permission to use this software is subject to your agreeing to the terms and conditions specified in the
agreement entitled ““Software User License Agreement” below. Please read carefully the Software User
License Agreement before you open the package. If you do not agree to the terms and conditions
specified in this agreement, do not open the package and return the product to your distributor, with the
program disk packaging seal unbroken for a full refund.

Software User License Agreement

The customer (hereafter referred to as Licensee") and Renesas Technology Corp. (hereafter referred to
as “"Licensor") do hereby agree to the terms and conditions as specified in this Software User License
Agreement (hereafter referred to as ~~ Agreement”) concerning the enclosed this software and its
explanatory manuals.

ARTICLE 1. Definition

1.1 “Licensed Software" shall mean the main unit of the C compiler, Assembler, Simulator and
related executable programs, the "Library" as defined in Section 1.3 below and documentation
such as explanatory manuals for the Licensed Software and all other materials provided to
Licensee in connection with use of the Licensed Software.

1.2 TDesignated System" shall mean the computer system to be installed Licensed Software. In case
of Network environment system, “"Designated System" shall mean the computer system to be
executed Licensed Software.

1.3 “Licensed Copy Number” shall mean the number which is printed at right upper part in this
sheet. And it shall mean the number of “Designated System” which you can install Licensed
Software and can make the copy of the Master Disk of Licensed Software.

1.4 “"Library" shall mean a group of function programs that enable operations including, but not
limited to input/output and character recognition and that are offered in the forms of a re-
locatable program.

1.5 “"Developed Software" shall mean software created by Licensee incorporating all or part of a
Library in accordance with the licenses granted to Licensee under the terms and conditions of this
Agreement.

ARTICLE 2. License Grant

2.1 Licensor grants Licensee a non-exclusive, non-assignable, non-transferable license;

(a) to use the Licensed Software solely on the Designated System for Licensee's business purpose of
creating and copying Developed Software to be incorporated in the Licensee's products installed
with Licensor's Renesas microcomputer (hereafter referred to as “"Licensee's Products");

(b) to make copies of Licensed Copy Number by installer program of Licensed Software on
Designated System for the purposes of using the Licensed Software in accordance with
subparagraph (a) above of this Section 2.1 to develop Developed Software in accordance with
subparagraphs (c) below of this Section 2.1;

(c) to merge the Library with one or more other programs to develop Developed Software, provided
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any portion of the Library so merged continues to be subject to the terms and conditions of this
Agreement; and

(d) to copy the Developed Software in connection with the manufacture and sale of the Licensee's
Products incorporating Developed Software, subject to provisions of Article 6 hereunder.

ARTICLE 3. Restrictions

3.1 Licensee shall not transfer the rights granted herein or allow any third party to use the Licensed
Software.

3.2 Licensee shall not remove the copyright notice contained in the Licensed Software.

3.3 Licensee shall not sublicense, rent, lease, or assign the Licensed Software.

3.4 Licensee shall not reverse assemble, reverse compile or otherwise reverse engineer the Licensed
Software.

ARTICLE 4. Title to Licensed Software

4.1 All right, title and interest in and to the Licensed Software are shall remain with Licensor. The
copyrights in the Licensed Software owned by Licensor are protected by Japanese copyright laws,
other applicable intellectual property laws and international treaty provisions.

Licensor retains all rights not expressly granted.

4.2 The copyrights in the Developed Software as a derivative work of Library shall be owned by
Licensee, provided, however, that copyrights in any part of Library contained in such Developed
Software shall remain the property of Licensor.

ARTICLE 5. Confidentialty

Licensee acknowledges that the Licensed Software contains valuable proprietary information and
trade secrets of Licensor. Licensee shall preserve the Licensed Software in confidence, and shall not
provide or disclose the contents of all or any part of the Licensed Software to any third party without
written authorization from Licensor.

Licensee will take appropriate action, by instruction, agreement or otherwise, with any persons
permitted access to the Licensed Software so as to enable them to hold the Licensed Software in
confidence and otherwise to satisfy their obligations under this Agreement.

This Agreement shall not restrict disclosure or use of any information which:

(a) can be demonstrated by Licensee to be in the public domain when received, or thereafter enters
the public domain through no fault of Licensee;

(b) is known to Licensee at the time of the disclosure by Licensor:
(c) is received from a third party without any restrictions on disclosure and use; or

(d) is independently developed by Licensee through persons who have not had access to the Licensed
Software.

ARTICLE 6. Term and Termination

6.1 This Agreement shall become effective upon Licensee's breaking the packaging seal of the
Licensed Software and shall remain in force until terminated by any of the provisions in Sections
6.2 and 6.3 below.

6.2 Licensee may terminate this Agreement at any time on thirty (30) day prior written notice to
Licensor.

6.3 In the event that Licensee shall be in default under this Agreement, Licensor may terminate this
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Agreement and all licenses granted hereunder by giving written notice of termination to Licensee,
effective upon its sending.

ARTICLE 7. Post-Termination Procedures

7.1 In the event of any termination of this Agreement, Licensee shall cease all use of the Licensed
Software and shall remove any and all copies of the Licensed Software from the Designated
System, shall remove any Libraries contained in the Developed Software from such Developed
Software (except for Libraries incorporated in the Licensee's Products already sold), and shall
destroy all such copies of Licensed Software.

7.2 Licensee shall complete all the obligations described in Section 7.1 above and shall submit written
proof to that effect to Licensor within thirty (30) days from the termination of this Agreement.

ARTICLE 8. Proprietary Rights Indemnification

8.1 Licensor shall defend or, at its option, settle any claim or proceedings brought against Licensee to
the extent that it is based on an assertion that the Licensed Software, used within the scope of this
Agreement, constitute direct infringement of any copyright, patent or trademark of a third party
and shall indemnify Licensee against all costs, damages and expenses finally awarded against
Licensee which result from any such claim, provided that Licensee notifies Licensor promptly in
writing of such claim or proceedings and gives Licensor full and complete authority, information
and assistance to defend such claim or proceedings, and further provided that Licensee gives
Licensor sole control of the defense of any such claim or proceedings and all negotiations for its
compromise or settlement.

8.2 Should the Licensed Software become, or, in Licensor's opinion, be likely to become the subject of
a claim of infringement, Licensor may procure for the Licensee the right to continue using the
Licensed Software or replace or modify it to make it non infringing. If neither of the foregoing
alternatives is reasonably available to Licensor, then Licensor's sole and exclusive remedy shall be
to terminate this Agreement, and to return to Licensee refund of License fees and other expenses
paid to Licensor.

8.3 Licensor's obligations under this Article 8 shall not apply to any claims of infringement based
upon (i) use of other than the latest upgrades of the Licensed Software made available to Licensee
by Licensor according to Section 9.2 hereunder if such infringement would have been avoided by
the use of such upgrades of the Licensed Software, (ii) combination, operation or use of the
Licensed Software with any programs, data or products not furnished by Licensor if such
infringement would not have occurred without such combination, operation or use, (iii) use of
the Licensed Software after receiving written notice from Licensor that the Licensed Software
infringes any patent, copyright or trademark of a third party, or (iv) claimant expresses its intent
to license or otherwise resolve its claim only with the Licensee of any apparatus incorporating the
Licensee’s Products. LICENSOR'S OBLIGATION UNDER THIS ARTICLE 8 CONSTITUTE
LICENSEE'S SOLE AND EXCLUSIVE REMEDY FOR A CLAIM OR PROCEEDINGS FOR AND
INTELLECTUAL PROPERTY INFRINGEMENT OF A THIRD PARTY.

ARTICLE 9. Limited Warranty, Indemnification and Limitation of Liability

9.1 Licensor warrants that it has the right to grant to Licensee a license to use the Licensed Software
and that Licensor has the right to enter into this Agreement.
EXCEPT AS SPECIFICALLY PROVIDED HEREIN, LICENSOR DISCLAIM ALL WARRANTIES,
REPRESENTATION, PROMISE OR GUARANTEE, EITHER EXPRESS OR IMPLIED,
STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OF MERCHANTABILITY AND
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FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL LICENSOR BE LIABLE FOR
ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND
INCLUDING WITHOUT LIMITATION, DAMAGES RESULTING FROM LOSS OF USE, LOSS OF
DATA, LOSS OF PROFITS OR LOSS OF BUSINESS. THE LICENSED SOFTWARE IS PROVIDED
TASIS", WITH ALL FAULTS.

LICENSEE AGREES THAT LICENSOR'S LIABILITY HEREUNDER FOR DAMAGES,
REGARDLESS OF THE FORM OF ACTION, SHALL NOT EXCEED THE CHARGES PAID BY
LICENSEE FOR THE LICENSED SOFTWARE. Notwithstanding the foregoing, in the event
Licensee find what it believes to be an error or failure of the Licensed Software, Licensor shall
make reasonable efforts to correct any such error or failure by taking measures which Licensor
deems appropriate provided that Licensee has returned the Customer Registration Card to
Licensor. However, Licensor does not guarantee that any measures described above will correct
all of the errors or failures.

9.2 The warranty coverage under this Agreement does not apply to any error or failure of the
Developed Software or any error or failure caused by a modification of the Licensed Software by
Licensee or by any negligent act or omission of Licensee.

9.3 In the event Licensor provides Licensee with any upgrades or error corrections of the Licensed
Software, Licensee may upgrade the Licensed Software under the terms and conditions
determined by Licensor. Licensor may request Licensee to submit the Master Disk for the
Licensed Software at the time an upgrade is conducted.

ARTICLE 10.Export Control

Licensee hereto represents and warrants that it shall not use any products, software and/or technology provided
by Licensor, or any other products, software and/or technology manufactured or developed by using them
(collectively hereinafter called, “Products’), for the purposes of disturbing international peace and security,
including (i) the design, development, production, stockpiling or use of weapons of mass destruction such as
nuclear, chemical or biological weapons or missiles, (ii) the other military activities, or (iii) any use supporting
these activities.

Licensee also represents and warrants that it shall not sell, export, dispose of, license, rent, transfer, disclose or
otherwise provide the Products to any third party, whether directly or indirectly, with knowledge or reason to
know that the third party or any other party will engage in the activities described above.

Furthermore, Licensee represents and warrants that it shall not directly or indirectly, export, re-export, transship
or otherwise transfer the Products in violation of any applicable export control laws or regulations promulgated
and administered by the governments of the countries asserting jurisdiction over the parties or their transactions.

ARTICLE 11.General

11.1 This Agreement constitutes the entire agreement between the parties concerning Licensee's use of
the Licensed Software and no waiver, alteration, modification or cancellation shall be binding
unless made in writing and signed by the parties.

11.2 If any provision of this Agreement shall be held by a court of competent jurisdiction to be illegal,
invalid or unenforceable, the remaining provisions shall remain in full force and effect.

11.3 This Agreement is made under and shall be construed in accordance with the Laws of Japan.
Licensee agrees that any disputes related to this Agreement shall be settled by the jurisdiction of
the court determined by Licensor.

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT AND AGREES
TO ALL TERMS AND CONDITIONS STATED HEREIN.

Renesas Technorogy Corp.
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